
DASHWOOD

Welcome to the Dashwood book template! This template kit is designed for historical romance novels, 
but it may suit other books as well. This kit will have your book reader ready in no time: it includes cover 
designs and interior layout templates for three of the most common trim sizes and ebook code that 
displays smoothly across all major platforms. We chose the kit’s fonts specifically to create an elegant, 
period-piece experience, and we added specialty text options to support all the dramatic details of a truly 
stunning story.

Before you get started, make sure you know some InDesign basics. If you know how to use threaded text 
boxes, paragraph styles, character styles, basic pages, master pages, and table of contents styles, this 
instruction manual can walk you through the rest.
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INSTALLING THE FONTS
Open the folder “01_Fonts.”

Unzip the files in this folder. Each zipped file includes an entire font family and the appropriate license 
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documentation. Not all files in each font family are used in the template you purchased, but the entirety 
of each font family is included in the font folder in case you need the additional family styles for related 
projects or customizations.

Install each font according to your operating system requirements. Most of the time you can select the 
files (either by clicking an individual font file once or by clicking and dragging to select many files), right 
click, and select Install from the menu that appears.

SELECTING THE APPROPRIATE INTERIOR TEMPLATE FILE
Choose your trim size. A trim size is the size your book will be when it’s closed. This template kit in-
cludes three common trim sizes: 5.25”x8”, 5.5”x8.5”, and 6”x9”. If you aren’t sure which to use, check the 
sizes of books you’d like yours to match. The sizes in this kit are especially appropriate for paperback 
books, so paperbacks make the best comparisons.

Verify your version of InDesign. There are two sets of files for this template kit: one for InDesign CC 
2020 or later and one for InDesign CS4 through InDesign CC 2019. Check your current versions so you 
know which set to use.

Open the folder “02_Interior Templates.”

Open the folder appropriate to your version of InDesign. For InDesign CC 2020 or later, use the folder 
“InDesign CC INDD Files”; for earlier versions, use “InDesign CS4+ IDML Files.”

Open the file suited to your trim size.

SELECTING THE APPROPRIATE COVER TEMPLATE FILE
This template kit includes two types of cover templates: templates for print and templates for ebooks 
(and any promotion efforts that require only the front cover). There are multiple versions of each type to 
suit whatever situation you need your book to fit.

FOR PRINT

Choose your trim size. A trim size is the size your book will be when it’s closed. This template kit in-
cludes three common trim sizes: 5.25”x8”, 5.5”x8.5”, and 6”x9”. If you aren’t sure which to use, check the 
sizes of books you’d like yours to match. The sizes in this kit are especially appropriate for paperback 
books, so paperbacks make the best comparisons.

Verify your version of InDesign. There are two sets of files for this template kit: one for InDesign CC 
2020 or later and one for InDesign CS4 through InDesign CC 2019. Check your current versions so you 
know which set to use.

Open the folder “03_Cover Templates.”

Open the folder appropriate to your version of InDesign. For InDesign CC 2020 or later, use the folder 
“InDesign CC INDD Files”; for earlier versions, use “InDesign CS4+ IDML Files.”

Open the file suited to your trim size.



FOR EBOOK

Choose your aspect ratio, either 1:1.5 or 1:1.6. The 1:1.5 ratio is called the Common Ratio in this kit. Pub-
lishers regularly use this ratio (common to many hardcover trim sizes) across many ebook distribution 
platforms. Although it is not always each platform’s ideal size, it almost always works with the thumb-
nail views and other elements of different distribution and reading platforms. The 1:1.6 ratio is the ratio 
currently recommended by KDP (Kindle Direct Publishing). It will display particularly well on Kindles 
and in the Amazon ecosystem. However, it is narrower than most print trim sizes, which sometimes 
means trimming down cover art.

Verify your version of InDesign. There are two sets of files for this template kit: one for InDesign CC 
2020 or later and one for InDesign CS4 through InDesign CC 2019. Check your current versions so you 
know which set to use.

Open the folder “03_Cover Templates.”

Open the folder appropriate to your version of InDesign. For InDesign CC 2020 or later, use the folder 
“InDesign CC INDD Files”; for earlier versions, use “InDesign CS4+ IDML Files.”

Open the file suited to your preferred aspect ratio.

UNDERSTANDING THE PARAGRAPH STYLES PANEL
The paragraph styles for this template kit are named in a way that makes them fairly easy to navigate. 
The cover templates have a smallish list of styles that are self-explanatory. The interior templates have a 
much longer list of styles, so we’ve organized these styles into groups/folders to help you navigate them. 
Only four styles are not in a group.

[Basic Paragraph]. This style is not used for this template, but we left it there for ease of use.

Text. This style is the style for standard, main body text. The bulk of your book will be in this style, and 
most of the other styles are based on it. This is the style to edit if you decide to change the body font of 
the book.

Text (1st paragraph). This style is for the first paragraph in a chapter. For most templates, it has no 
indent. It may also have some additional styling or spacing.

Text (after scene break). This style is for the first paragraph after a scene break within a chapter. For 
most templates, it has no indent. It may have some additional styling or spacing.

The remaining paragraphs styles fall into one of the following groups/folders. To find the styles, open 
the Paragraph Styles panel and click the > arrow next to the appropriate group.

Copyfitting Aids. This group includes copies of the Text paragraph style with a variety of different 
keep options. For more information on these styles, check out the “Using the Copyfitting Aids” section 
of this manual.

Special Text. This group includes styles for block quotes/letters, poetry/songs, code, digital communi-
cation, and other special text for your genre. These styles appear within the main text, not at a chapter 
start or part break.



Chapter Starts. This group includes the styles for part or section breaks and the styles for all varia-
tions of the chapter breaks/starts for this template kit. If it belongs at the beginning of a chapter, it’s 
in here.

Table of Contents Page. This group has all the styles for the table of contents, and these styles are built 
in to the table of contents style definitions for the template.

Frontmatter. This group includes all the styles for frontmatter text. This includes various title styl-
ings, author name formatting, copyright text, and dedication styles. If you want to edit the display 
font, edit the Title (full page title) font and most (if not all) the display fonts will update.

Master Pages. If a bit of text is on a master page, the styling for it is in this group.

REPLACING INTERIOR TEMPLATE TEXT WITH YOUR TEXT
Once you’ve opened the book interior file in your trim size, it’s time to pour your book text into the template!

FRONTMATTER

All the paragraph styles for the frontmatter elements are in the paragraph style group called 
Frontmatter. To find them, open the Paragraph Styles panel and expand the folder called Frontmatter.

Not every book needs every frontmatter page included in the template. Delete and rearrange pages as 
appropriate for your book.

For the half-title page, simply replace the placeholder text on the very first page with your book’s title.

For the copyright page, replace the placeholder text with your book’s information and any additional dis-
claimers or contact information appropriate for your book. Make sure the first paragraph of the copy-
right page has the Copyright (1st line) style applied and all the other paragraphs on the copyright page 
have the Copyright style applied. This will ensure your book’s page breaks are appropriate in print and 
ebook formats.

For the full-title page, replace the placeholder text at the top with your book’s title and the placeholder 
text at the bottom with the book author’s name. To retain appealing spacing for books with multiple au-
thors, you may need to adjust the space before the author name by editing the Author name style in the 
Frontmatter style group folder. If you would like to include a subtitle or “a novel by” before the author’s 
name, apply the Author name style to the subtitle or “a novel by.” Notice that the text is the same size as 
the author’s name. To make the text smaller, as shown in the sample template, highlight the subtitle or 
“a novel by” and apply the Subtitle style from the Character Styles list. This style changes only the size of 
whatever text is highlighted.

The table of contents for this template can display in two ways: one prepped for print ([Default]) and 
one prepped for ebooks (TOC for Ebook). You can tell the difference visually because the Default style 
includes page numbers and the TOC for Ebook style does not. If the style you want is already placed on 
the table of contents page, leave it as it is until you have placed your main text. Then come back to this 
page and click on the text box containing the table of contents. Then go to the top menu in InDesign and 
select Layout > Update Table of Contents. If your table of contents needs more space than what one page 



can provide, you can flow the overset text onto the last blank page of the frontmatter. Add extra pages as 
necessary.

For more details on using the TOC for Ebook style, go to Exporting for EPUB & Other Ebook Formats 
later in this manual.

This  template has a page set aside for the dedication. If you have a dedication, fill it in, then apply the 
Dedication paragraph style from the Frontmatter paragraph style group.

Every frontmatter page, excepting the full-title page and preface page, should have the Frontmatter 
master page applied. This master page is tagged with the color blue. 

To include the flourish graphic on the full-title page, apply the Full Title w/ Image master page to your 
full-title page. If you need to adjust the graphic on the full-title page in any way to accommodate chang-
es to the text, you’ll need to do the adjustment on the master page. Additionally, the color of this graphic 
can be changed by selecting the graphic and creating/using a different color swatch in the Swatches 
panel.

If you choose to include a preface, by sure to apply the Preface master page to it. Both the full-title and 
preface pages are tagged with the color blue.

RUNNING HEADERS & FOOTERS
This template arrives with placeholder text in the header or footer for the author name and book title. To 
replace the placeholder text with your book’s information, open the master page A-Basic Text Spread. It 
has a green label.

Edit the appropriate text boxes.

Any other pages with running headers and/or footers will update automatically.

MAIN TEXT
The threaded text boxes for the primary text frame begin on the page with the first part or section break. 
To replace this text, click into the text box, press Ctrl/Cmd + A, then delete all the selected text. Select 
the Text paragraph style. Now you can copy and paste (or place) your text in this text frame and it will 
autoflow enough pages to hold your entire text.

After the text is placed, go through and place part or section dividers, chapter breaks, and special text as 
appropriate. Make sure the paragraph styles are applied without overrides to ensure the best results.

PART OR SECTION DIVIDERS
Not all books need part or section dividers, but if your book does, here’s what you need to know. 

This template kit includes a section break title, a location stamp, and a time stamp. All three of these 
paragraph styles can be found under the Chapter Starts folder/group. You may not need all three ele-
ments, but please note that the Section Break style is the only style that will automatically start on the 
next available right-hand page and have lots of white space above it on the page. The Section Location 
Stamp style is spaced to follow the section break title, the Section Time Stamp style is spaced to follow 
the location stamp—neither has a settings to force them to start on the next available right-hand page or 
to give them extra white space above them if they’re used without Section Break.



The following combinations of styles will require you to manually adjust ruling or spacing of the para-
graph styles.

•	 Section Break + Section Time Stamp. The time stamp won’t be spaced far enough from the sec-
tion break title. You will need to increase the space before the time stamp.

•	 Section Location Stamp + Section Time Stamp (or Section Location Stamp only). Removing the 
section break title removes the paragraph rule above (which makes the paragraph start lower 
on the page than the top margin) and forced right-hand page start. You will need to apply a 
paragraph rule to the Section Location Stamp style. To ensure that your section break starts on 
a right-hand page, you will need to adjust the start paragraph settings. You can do this in the 
paragraph style options by going to Keep Options > Start Paragraph and selecting “On Next Odd 
Page” from the drop-down menu.

•	 Section Time Stamp only. Removing the section break title removes the paragraph rule and 
forced right-hand page start. You will need to apply a paragraph rule to the Section Time Stamp 
style. To ensure that your section break starts on a right-hand page, you will need to adjust the 
start paragraph settings. You can do this in the paragraph style options by going to Keep Options 
> Start Paragraph and selecting “On Next Odd Page” from the drop-down menu.

All section break pages should have the Section Break master page applied. This master page is tagged 
with the color purple, and it includes a flourish graphic. The color of this graphic can be changed by 
selecting the graphic and creating/using a different color swatch in the Swatches panel. If you do not 
want to include the graphic, you can right-click on the image and select Hide. 

CHAPTER STARTS
This template has three options for your book’s chapter breaks. The styles for all three options are in the 
Chapter Starts folder/group in the Paragraph Styles panel.

Option 1: Chapter Title Only
To use this option, apply Chapter title: w/o chapter# to the chapter title. If your chapters have no titles 
and are simply called “Chapter 1,” “Chapter One,” “One,” etc., use this style. You will need to apply the 

Option 1 Option 2 Option 3



Chapter Start master page to the page containing the chapter title. This master page does not have the 
flourishes that are included in chapter starts that use single numerals.

Option 2: Chapter Number + Chapter Title
To use this option, apply Chapter #: before title to the chapter numeral and Chapter title: after chapter # 
to the chapter title.

Option 3: Chapter Number Only
To use this option, apply Chapter: # only to the numeral. 

To add flourishes to the numerals in options 2 and 3, you will need to apply the Chapter Start with 
Flourishes master page, which is tagged with the color green. This master page will automatically add 
flourishes to the space around the chapter numeral. These flourishes are only graphics—they are not 
coded to interact with your numeral in any way. They are designed to accommodate the width of a 
double-​digit numeral. If you change the positioning/spacing of the chapter numeral or need to increase 
the width between the flourishes (possibly to accommodate a triple-digit numeral), you will need to ad-
just the placement of the flourishes on the Chapter Start with Flourishes master page. Remember, this 
will change the position of the flourishes on every chapter start that the Chapter Start with Flourishes 
master page is applied to.

The color of these flourishes can be changed by selecting the graphics and creating/using a different 
color swatch in the Swatches panel.

If you do not wish to include flourishes in your template, apply the Chapter Start master page to all 
chapter starts.

SCENE BREAKS
This template kit uses a simple scene break with no ornament. The last paragraph in a scene should have 
the Text paragraph style applied. The first paragraph in the new scene should have the Text (after scene 
break) paragraph style applied. There should be no paragraph between these two styles.

ITALIC TEXT
This template has several character styles for italic text, so any italicized parts of the book can be done in 
styles rather than in local overrides. This makes for a cleaner ebook export and makes style changes and 
text reflow easier and cleaner. These are the italic character styles in this template:

•	 Italic (this makes text italic)
•	 Italic + small caps (this makes the text italic and small caps; this is not a necessary style for all 

books)
•	 No break + italic (this makes the text italic and makes it impossible for a line break to interrupt 

the selected text; see more on this in the Using Copyfitting Aids section of this manual)

You can apply italic styles in two ways. 

1.	 You can manually apply the italic style to each instance of italic text throughout your book.
2.	When you have replaced the placeholder main text with your own, you can run a Find/Change 

search. 



1.	 To do so, press Ctrl/Cmd + F to pull up the Find/Change menu in InDesign. 
2.	Click in the empty box below “Find Format.” 
3.	 In the Find Format Settings window that pulls up, click “Basic Character Formats,” and in 

the “Font Style” field, type “Italic,” then click “OK” at the bottom of the menu. 
4.	 Click in the empty box below “Change Format.” 
5.	 In the Change Format Settings that pulls up, click “Style Options” if it isn’t already selected, 

then in the “Character Style” field, type “Italic,” then click “OK” at the bottom of the menu.
6.	 In the main Find/Change menu, click “Change All.” (If your book has no italics, the “Change 

All” option will be grayed out.)

SPECIAL TEXT
This template kit includes specially styled text for block quotes or letters and for poetry or songs.

Block Quotes
If the block quote or letter is a single paragraph long, use Block quote (solo).

If the block quote is two paragraphs long, use Block quote (1st paragraph) for the first paragraph and 
Block quote (last) for the second.

If the block quote is three or more paragraphs long, use Block quote (1st paragraph) for the first para-
graph, Block quote (last) for the last paragraph, and Block quote (middle) for all the paragraphs in 
between.

Poetry
If the poem or song is a single line long, use poetry (single line).

If the poem is two lines long, use poetry (1st line) for the first line and poetry (last line) for the second.

If the poem is three or more lines long, use poetry (1st line) for the first line, poetry (last line) for the last 
line, and poetry (middle line) for all the lines in between.

If the poem has one or more stanza breaks, apply poetry (stanza end) to the last line in each stanza.

RESIZING A PRINT COVER TEMPLATE
The print cover templates in this kit are set up for a half-inch spine. This spine width is unlikely to match 
your book. Before replacing the placeholder text on the cover with text tailored for your book, adjust the 
page size for your book’s spine width.

1.	 Determine the number of pages your book’s interior will have. Use the number of pages to calcu-
late your spine width according to your printer’s specifications.

2.	In the cover template document for your trim size, click File > Document Setup. Make the width 
of the page 2 × your trim size width + your spine width. (Each cover document has 2 × your trim 
size width defined in the gray help box next to the page.)

3.	 Then click Layout > Margins and Columns. Keep the column number set to 2. Replace the gutter 
width with your new spine width.

4.	 The gutter lines mark where your spine is. You can adjust the placement of the cover text to fit 
your book’s new layout. Note that short books may be too small for text to fit on the spine. Try to 



leave at least 1 pica of space on the spine to the left and to the right of the spine text to account 
for margins of error in printing and trimming.

USING THE COPYFITTING AIDS
This section has a video tutorial that demonstrates the use of all these elements. Check it out here: 
LooseleafEP.com/copyfitting-aids-demo/.

PARAGRAPH STYLES TO AVOID ORPHANED LINES & UNEVEN BASELINES

To see a demonstration of the method outlined below, watch this copyfitting tutorial: LooseleafEP.com/
copyfitting-aids-demo/.

This template kit is set up to avoid widowed lines at the ends of paragraphs. (A widowed line is a final 
line of a paragraph that appears alone at the top of a page.) This template setting means that, occasional-
ly, a spread will have one page that ends a line earlier than the other page, and this can make the spread’s 
margins look uneven. Fixing this is simple enough but can get obnoxious without paragraph styles set 
up for this purpose.

KEEP OPTION STYLE VARIATIONS
This template kit has a variety of styles based on the Text paragraph style (the basic text style for this 
template) with different keep options so you can adjust each spread so both pages end on the same line. 
It is common for some spreads in a book to end a line early on both pages to facilitate this clean, even 
baseline.

To fix an uneven baseline, if you can’t find a way to lengthen or shorten paragraphs on the page to make 
the text fill the margins top to bottom, simply force a spread to end a line early by using a combination 
of these Keep Option style variations:

•	 Text (keep first 2): keeps the first two lines of a paragraph together
•	 Text (keep w/ next): keeps a paragraph with the paragraph that follows it
•	 Text (keep last 3): keeps the last three lines of a paragraph together
•	 Text (keep last 4): keeps the last four lines of a paragraph together
•	 Text (keep last 5): keeps the last five lines of a paragraph together
•	 Text (keep last 6): keeps the last six lines of a paragraph together
•	 Text (keep last 7): keeps the last seven lines of a paragraph together

This method is also useful for expanding a chapter that ends without enough lines on the final page to 
look balanced. A good rule of thumb is to include at least 6–7 lines whenever possible on the final page of 
a chapter.

SPECIAL TEXT WITH EXTRA SPACE AFTER
The specialty text paragraph styles in this template kit (e.g., poetry, block quotes, and code) are set up to 
have half a line’s leading extra space above them and half a line’s leading below. This ensures a clean look 
when all the specialty text appears on the same page. However, if the specialty text begins at the top of a 
page or is split across two pages, this spacing can force one page to end half a line too early.

To fix this, simply use one of the styles from the Special Text paragraph styles group labeled [Type of 
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Text] (last, extra space after)—for example, Block quote (last, extra space after). This style will correct 
the baseline. Most readers will not notice the extra space below the special text (optical illusion eye tricks 
help hide it), and fewer of them will notice it than will notice an uneven baseline.

CHARACTER STYLES TO AVOID WORD & LETTER STACKS  
OR SHORTEN/LENGTHEN PARAGRAPHS

To see a demonstration of the method outlined below, watch this copyfitting tutorial: LooseleafEP.com/
copyfitting-aids-demo/.

This template kit includes two character styles to speed up copyfitting: No break and No break + italic.

WORD STACKS
When you encounter a word stack (the same word appearing twice or more in a row at the beginning or 
end of a line), you can use the No Break styles to manually tell InDesign which words to keep together. 
This lets you force words onto particular lines without adjusting a paragraph’s tracking (tracking is a 
change that can get very visible very quickly). Simply highlight the words you want to keep on the same 
line and apply the No break character style (or the No break + italic style if you’re dealing with italic 
text).

You can also use the No Break styles to correct word stacks in the middle of a line by adjusting how lines 
around the stack begin and end.

PARAGRAPH SIZE ADJUSTMENT
When you run into a page with an uneven baseline or a chapter that ends without a good-looking 
amount of lines, you can correct this by expanding or contracting the size of some of the paragraphs in 
the chapter. One way to do this uses the No Break–based styles.

To condense a paragraph with a short last line, select the final line and a significant portion of the line 
above it, then apply the No Break and/or No break + italic styles as appropriate. This will often force 
the paragraph to contract. InDesign will reflow other portions of the paragraph for its best guess at 
good spacing for the paragraph at the new size. (Check your H&J Violations to make sure the paragraph 
doesn’t end up too tight as a result.)

To expand a paragraph with a long last line, select the first word or two of the last line as well as the 
last word or two (or more, if needed) of the second-to-last line. Apply the No Break and/or No break + 
italic styles as appropriate. InDesign will reflow other portions of the paragraph for its best guess at 
good spacing for the paragraph at the new size. (Check your H&J Violations to make sure the paragraph 
doesn’t end up too loose as a result.)

GREP STYLES IN TEXT TO AVOID ORPHAN WORDS

This template kit’s Text paragraph style is the core style for all body text. All the other body text fonts 
are based on it and will adjust when it is edited. This style’s definitions include a GREP adjustment to 
automatically avoid orphaned words at the end of paragraphs. The out-of-the-box definitions for this 
style force every line at the end of a paragraph to be at least four letters long plus ending punctuation 
(three letters long if the ending punctuation is a terminal mark + a closing quotation mark). This means 
a minimum of 5 characters appears on the final line of every paragraph.

https://looseleafep.com/copyfitting-aids-demo/
https://looseleafep.com/copyfitting-aids-demo/


If you want a stricter definition of an orphaned word, you can adjust this automatic style by opening up 
the Text paragraph style and selecting “GREP Style” from the options on the left of the paragraph style 
pop-up menu.

In the main box of this portion of the menu, click on the portion that says “To Text: (.){5}$.” This lets you 
edit the definition for the GREP style. Change “5” to whatever number of characters you want to be the 
minimum on your paragraphs’ final lines. Then click “OK” at the bottom of the paragraph style pop-up 
menu to finish editing the style.

EXPORTING TO EPUB & OTHER EBOOK FORMATS
To export your book as a valid EPUB with custom styling to make it reader ready, you’ll need to use In-
Design’s basic EPUB export options and add the additional CSS included in this template kit.

An EPUB file is compatible with most ebook retailers and platforms (Apple, B&N, Kobo, etc.). EPUB files 
can also be converted easily to Kindle-compatible formats for the Amazon ecosystem.

BEFORE EXPORTING

Before exporting to EPUB, we recommend saving a separate copy of your book’s interior and replac-
ing the table of contents with one generated using the TOC for Ebook table of contents style. This style 
removes elements of the table of contents that are irrelevant to an ebook (page numbers, for example) 
and elements that don’t display well across all platforms. This style also generates internal links between 
your table of contents and the chapter breaks in your book.

EPUB EXPORT MENU

To export your book as an EPUB, select File > Export or hit Ctrl/Cmd + E.

In the “Save as type” portion of the save menu, select “EPUB (Reflowable) (*.epub).”

Choose somewhere to save your file and give it an appropriate file name using the save menu, then click 
Save.

InDesign will open the EPUB – Reflowable Layout Export Options menu. 

GENERAL
This kit works best with the following options in the “General” section of the EPUB Export Menu.

Version. Choose EPUB 3.0.

Cover. If you have set up your book file with the cover as the first page, choose “Rasterize First Page.” 
If your cover is a separate file, choose “Choose Image,” then navigate to your cover image in the File 
Location selection menu. (You may need to adjust the file types your computer looks for. It defaults 
to look for GIFs, but JPGs and GIFs both work. PNGs usually work, but occasionally have hiccups on 
some reading platforms.)

Navigation TOC. Choose “Multi Level (TOC Style).” For TOC Style, choose “TOC for Ebook.” This style 
is tailored for ebook exports.



Content Order. The default (“Based on Page Layout”) should be fine, but if you have included images 
or other non-text elements in your book, you may need to anchor your images to get them to display 
at appropriate places in the book.

TEXT
The settings you use in the “Text” section of the EPUB Export Menu will depend on the content of your 
book, but below are some guidelines and things to consider.

Options. If you have used forced line breaks to control the look of your chapter headings, checking the 
option to Remove Forced Line Breaks usually gets you a cleaner look in the EPUB.

Footnotes. This template kit is not set up for footnotes. Look to more general tutorials if you have add-
ed footnotes, and make sure to review the latest guidance for “roundtripping endnotes” to make sure 
they’ll work for your reader across as many platforms as possible.

Lists. Generally, leaving these at the default settings will work. If you are using a template that has an 
option for automatically numbered chapter title paragraph styles (for example, our Enceladus tem-
plate), pause for a moment.

If you are not comfortable editing EPUB files and HTML, then in this ebook-prepared version of 
your interior, use the unnumbered version of the paragraph style. You’ll need to type the numerals 
manually. 

If you’re comfortable editing EPUB files and HTML, then adjust Numbers to “Covert to Text.” On 
some platforms, this can create a line break after the numeral because InDesign inserts a <span> tag 
around the numeral that’s been converted to text. Manually removing this <span> tag (both the open-
ing tag and the closing tag) from the ebook’s HTML will resolve the issue.

OBJECT,  CONVERSION SETTINGS,  JAVASCRIPT
The graphics in this template are set up for print only. They will automatically be omitted during the 
ebook export to simplify your ebook formatting process.

If you understand ebook coding and want to include the graphics in your ebook conversion, release the 
graphics from the master pages by navigating to the live page they appear on and holding Ctrl + Shift 
while clicking on each graphic you want to release (Cmd + Shift + Click on a Mac). Once the graphics are 
released from the master page, you can anchor them to the text boxes they appear near. Keep in mind 
that many graphics will need to have their sizing adjusted depending on which ebook platform the read-
er uses, so you may need to have different ebook versions for different platforms.

HTML & CSS
This template kit is set up to require “Include classes in HTML.”

Generate CSS. Keep “Generate CSS” checked.

Page Margin. No additional margins should be necessary, so keep those options at 0 pixels unless you 
have a good reason not to.

Local Overrides. If you have used a lot of local overrides, you may want to preserve them. However, 
each local override generates custom CSS code for that local override, and that can make your CSS 
styles much more bloated than necessary. Try to use styles whenever possible.



Embeddable Fonts. The fonts included in this template’s styles have licenses that allow them to be 
embedded in ebooks (this includes the body text font, the display font(s), and any fonts relevant to the 
special text styles). However, not all ebook reading platforms will display custom font choices. You 
are free to choose to embed the fonts or not as suits you and your readers—the template will create a 
smooth, readable ebook either way.

Additional CSS. Click “Add Style Sheet.” Navigate the Open a File dialog box to the template kit, then 
open “04_Ebook Additional CSS.” Select “EbookModifications.css” and click Open. This style sheet 
includes CSS styles that replicate design elements that InDesign can’t export. (Not all stylistic ele-
ments from InDesign translate well across ebook platforms. If an element required platform-specific 
customizations to work well, we’ve omitted it from the ebook to simplify your workflow.)

METADATA
In the metadata section, include at least the title of your book, the creator, the date, and the publisher. 
The date must be formatted according to current EPUB standards. These standards are evolving, but it’s 
always safe to just list the four-digit year (e.g., 2020).

VIEWING APPS
Use or ignore this part of the menu as you prefer. None of it will affect how the template works. This is 
where you can select which apps will automically open to display your EPUB after export.

KINDLE-READY FILES

The previous instructions will get you an EPUB file. To prepare that file for sale through Amazon, the file 
will need to be converted. Amazon will take EPUB uploads through its KDP interface and convert them 
automatically for you, but if you want to check the files first or if you want a version of the file you can 
sell directly to Kindle users, you can use Kindle Previewer to convert your EPUB.

Download the most recent version of the program from Amazon (the location for the download page for 
this program changes, so we recommend running a web search for its current location).

In Kindle Previewer, click Open > Book and navigate to your EPUB file.

Kindle Previewer will convert the book and let you view it on various Kindle platforms using the Kindle 
Previewer interface.

When you are satisfied with your book, click Export Book, then save the book to an appropriate location. 
The book will save as a MOBI file, which is slightly different from Amazon’s proprietary ebook file for-
mat, but the Amazon format is mostly a MOBI file with a special Amazon coat wrapped around it. Kindle 
devices will be able to read this format, and you can sell it directly to Kindle users.

UNDERSTANDING YOUR LICENSE
Each template license includes unlimited personal uses and rights to use for a single commercial book 
or other published product. If you want to license this template for a series of books, email details about 
your project (number of books, etc.) to production@looseleafep.com to get a discounted quote on addi-
tional licenses.



Personal use: Anything you make for yourself or for others with no commercial motives.

Commercial use: Anything you make for yourself or for others that has a commercial purpose. This 
includes items an individual or company sells as well as items an individual or company gives away for 
free to promote a commercial enterprise. For example, if a company provides a free download to anyone 
who joins its email list, that free download serves a commercial purpose.


